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PersonalBrain 6 Release History 
 
PersonalBrain 6 is a paid upgrade from PersonalBrain 5. If you purchased a new license of PersonalBrain 5 (not 
including upgrades) after February 1, 2010, sign up for the free upgrade. Note: Opening a Brain in PersonalBrain 6 
makes irreversible changes to your Brain database, making it incompatible with version 5.5. If you want the option to 
go back to version 5.5, you must make a backup of your Brain prior to opening it with PersonalBrain 6. 
 
Note: Publishing and synchronization of files via WebBrain.com is subject to additional monthly fees. 
 
Version 6.0.7.9 
February 23, 2012 

• Faster Sync, especially when many links have been modified 
• Fixed: Some Brains cannot be opened due to errors while repairing favicons (a different issue from the 6.0.7.8 

fix) 
• Fixed: Untyping of Thoughts may not be synced 

 
Version 6.0.7.8 
February 8, 2012 

• Updated version of notes editor. Fixes image copy and paste issues on Mac OS X. 
• Fixed: Some Brains cannot be opened due to errors while repairing favicons. 

 
Version 6.0.7.7 
February 1, 2012 

• Fixed: Google Calendar sync issue with recurring events. 
• Fixed: Favicon files may be stored twice and the favicon may not show next to the Thought 
• Fixed: The default name for URLs may not be the correct part of the domain name 
• Fixed: Favicons cannot be found from Brains that have been opened in version 7  

 
Version 6.0.7.5 
October 4, 2011 

• Updated Dutch localization 
• Fixed: Hangs on Windows shutdown if docked 
• Fixed: Notes editor sometimes puts the cursor in the wrong position after pressing the home key (#1894) 
• Fixed: Exception in logs on drag and drop 
• Fixed: No progress bar should be shown when only a single file is being moved 

 
Version 6.0.7.4 
September 1, 2011 

• Fixes 
o Fixed: Shutdown of Windows can cause PersonalBrain to hang 
o Fixed: Thought types removed via a sync continue to show in the UI until a restart 
o Fixed: If a link to an Outlook item is clicked and Outlook is not running, Outlook displays an error 

message 
o Fixed: Spellcheck sometimes incorrectly highlights words as if they are misspelled 

 
Version 6.0.7.3 (Test) 
August 1, 2011 

• Fixes 
o Fixed: Changing the dictionary clears the content of the current note (occurred only in the 6.0.7.2 test 

release) 
o Fixed: Changing the dictionary turns on thought spellchecking if it was disabled 

 
Version 6.0.7.2 (Test) 
July 30, 2011 

• Faster instant activation for very large brains 
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• Added Portuguese translation, including tips 
• Fixes 

o Fixed: Editor icons display incorrectly in Mac OS X Lion 
o Fixed: Problem with opening a thought URL to an already opened brain 
o Fixed: Virtual thought pins do not display after a brain is closed and opened 
o Fixed: Renaming an attachment can cause an assigned icon to disappear 
o Fixed: Graphics copied and pasted from one note to another are changed  
o Fixed: In notes, the text cursor does not change color if the notes colors are changed 
o Fixed: If you attempt to move a file into your Brain which is no longer in its original location, 

sometimes the progress tracker appears above the message box 
• Changes for future WebBrain compatibility 

 
Version 6.0.7.1 
May 19, 2011 

• Updated German localization 
• Fixed: Possible problem restoring BrainZips from brains created using version 6.0.6.7 or 6.0.6.8 
• Fixed: Removal of wallpaper does not sync to WebBrain, changes to wallpaper are not received from 

WebBrain 
 
Version 6.0.7.0 
April 20, 2011 

• Compatibility with the new version of WebBrain 
• Fixed: When opening a Brain created in version 6.0.6.7 or 6.0.6.8, sometimes an unnecessary error message 

is displayed. 
 
Version 6.0.6.9 
April 18, 2011 

• Fixed: Version metadata inconsistencies in Brains created by version 6.0.6.8 and 6.0.6.7 could cause system 
notes not to be saved properly and may result in problems related to WebBrain and Google Calendar sync 
functions. This problem applies only to Brains that were created by version 6.0.6.8 or 6.0.6.7. These problems 
are fixed automatically by this release. 

 
Version 6.0.6.8 
April 15, 2011 

• Fixes 
o Fixed: The thought type icon does not override attachment based icons on instances of the type 
o Fixed: Paste of multiple URLs from text files or notes into attachments sometimes does not work 
o Fixed: Can't click on checkboxes in floating notes windows 
o Fixed: Sync should be stopped when a brain is closed 
o Fixed: Problems with detecting registration in some cases on Windows XP (cause problems with 

spellchecking, insert table in notes, and other pro/core-only features) 
o Fixed: Problems with attachment list display when there are no files, but there are URLs (when one 

URL is deleted, others also disappear temporarily even though they are not really gone) 
o Fixed: Wallpaper does not work if brain is stored in a location with non-Latin characters 
o Fixed: A thought’s external attachment gets deleted if it is a single attachment 

 
Version 6.0.6.7 
April 7, 2011 

• Faster Instant Activate 
o Finding thoughts using the instant activate search is up to 10 times faster. (This also speeds the 

process of creating Thoughts) 
• Updated Dutch and German localizations 
• Fixes 

o Fixed: Deleting a link can sometimes cause a hang due to the inability to click on the dialog box which 
appears behind the progress bar 

o Fixed: Sometimes icons do not update on cut and paste of files 
o Fixed: Calendar taskbar buttons on Mac should not have an outline 
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o Removed redundant calls to update attachments list 
o Fixed: Attachment sort preference causes problems when switching languages 
o Fixed: When renaming a thought and selecting all text then typing, the thought type and tags changes 

are not applied 
 
Version 6.0.6.4 
February 3, 2011 

• Enhancements 
o A progress bar is displayed when attachments are being copied/moved during copy/paste and drag 

and drop operations. 
o Advanced search values now get reset only after a new regular search has been performed. 
o Updated French, German and Chinese localizations 
o Only one error message is displayed if unable to delete multiple files. 
o Sync downloads data in chunks to ensure that large downloads complete and can be resumed 
o Better handling of brain:// links from 3rd party applications on Windows o{*> 

• Fixes 
o Fixed: Google calendar sync problems caused by date parsing and unnecessary white spaces. 
o Fixed: Text for reminder after one year is plural. 
o Fixed: Problem with import of outline. 
o Deletion of multiple files at a time is more reliable. 
o Fixed: On failure to delete multiple files, a separate message is displayed for each file. 
o Clarified WebBrain error message when user account cannot be validated. 

 
Version 6.0.6.3 
January 18, 2011 

• Sync 
o Resumes interrupted upload of sync data 
o When an upload is interrupted, shows the amount of data uploaded 
o Added "Sync now" checkbox to sync dialog so that sync settings can be modified without initiating a 

sync 
• Enhancements 

o When pasting an outline, paths to attachments are added as external attachments, just like URLs 
o On copy/paste of files when there is an existing file conflict, a “yes to all” option is available 
o Moves themes to user directory so that themes can be modified without needing administrator level 

access 
• Fixes 

o Fixed: Context-clicks in calendar are not detected on Mac OS X 
o Fixed: In some situations, the snooze button can't be clicked 
o Fixed: When an event is deleted in PB but modified in Google Calendar, problems can occur 
o Fixed: If a Brain name has the ‘#’ character in it, problems can happen with export 
o Fixed: Issue with customized notes CSS files and WebBrain 
o Fixed: About dialog does not show user name properly if foreign characters are included 
o Fixed: Changes to pins made via drag and drop are not saved 
o Various language resource fixes 
o Fixed: Problem with tools tab names not being localized in 6.0.6.2 
o Fixed: Right-click on empty attachment area does not show context menu 
o Fixed: On paste/duplicate/import of a Thought, the creation and modification dates are not set to the 

current time, but the times of the originating thought 
o Fixed: “Insert Table” does not work after "Open Notes Window" on the active thought 

 
Version 6.0.6.2 
December 22, 2010 

• Updated French localization 
• Minor Enhancements 

o New utility to check for modified attachments throughout a Brain 
§ This should be done prior to sync if internal file attachments within a Brain have been 

modified using a 3rd party utility 



 

© TheBrain Technologies LP Page 4 of 24  

 

o The sorting preference for attachments is saved 
o Drag and drop to virtual Thoughts is now supported 
o The [Enter] key can be used to activate a Thought in the selection 

• Fixes 
o Fixed: Deleting a tag while in expanded view shows the tag after it has been deleted 
o Fixed: Tables in notes disappear after activating another thought if there is no other content 
o Fixed: Setting the sort option to “modified” in the Thought tool renders the "Select Attachment to 

Open" Window inoperable 
o Fixed: Thought Type menu is not drawn correctly on Mac OS sometimes 
o Fixed: Sometimes duplicate attachments appear on a Thought 
o Fixed: Some URLs don't show the correct favicons in some cases 
o Fixed: The "include index" option should not be displayed when exporting to folders 
o Fixed: Photoshop shows a "null" entry in the Add Attachment dialog 
o Fixed: Changing the UI language resets the tools layout 
o Fixed: Past Thought List scroll button does not show in the correct spot sometimes 
o Fixed: Thoughts show twice in the plex during mouseover of links in certain cases 
o Updated notes editor library 
o Increased timeout tolerance when downloading sync information and added additional 

troubleshooting information to logs 
• Mac OS Specific Fixes 

o Improved coloring of search results and calendar tabs 
o Fixed: Address icons do not show properly in some cases 
o Fixed: Export to folders does not work in some cases 

 
Version 6.0.6.1 
December 2, 2010 

• Improvements 
o Faster loading of Brains with many tags 

• Fixes 
o Fixed: Wallpaper sometimes does not load when switching between brains 
o Fixed: Advanced search filtering by Thought type does not work 
o Fixed: Sometimes changes to wallpaper are not synced to WebBrain 
o Fixed: Typo in installer text 

 
Version 6.0.6.0 
November 29, 2010 

• Added support for a new command line parameter (-n) to force a new instance of PersonalBrain 
• WebBrain Sync Fixes 

o Fixed: Problems related to sync of types 
o Fixed: Can’t login to WebBrain using an email address 
o Fixed: When tags are removed, their removal is not synced. Note: Tag removals done with prior 

releases of PersonalBrain will not sync even with the force sync command and must be manually 
removed. 

• General Fixes 
o Fixed: Hyperlinks not showing in notes on exported simple HTML brains 
o Fixed: Does not always ensure every system attribute has been created during startup. 
o Fixed: The tip about filtering is incorrect 

 
Version 6.0.5.9 
November 23, 2010 

• Fixes 
o Fixed: When there is a positive failure to authenticate with WebBrain, a retry should not be initiated 
o Fixed: WebBrain Sync error messages should not be displayed until retrying has completed 

• Windows Specific 
o Context menu does not disappear on second press of menu key 
o Outlook messages do not replace any existing note 
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Version 6.0.5.8 
November 19, 2010 

• WebBrain Sync 
o If there is a problem with the sync process, an automatic recovery is done using a retry process 
o Error messages are more relevant and provide advice on how to overcome issues 
o The speed of toolbar sync button animation is slower to be less distracting 
o Fixed: If a Thought icon file is missing, it causes the icon file to be removed from other Brains that 

sync with it 
o Fixed: Thoughts copied into a Brain from another Brain are not synced 
o Fixed: The message “No sync points found” occurs when a brain is synced immediately after creation 

• Performance 
o Optimized display when large numbers of thoughts are visible in the plex at once 
o Improved robustness when recovering data from the backup 

• Fixes 
o Fixed: Toolbar does not show Brain buttons when first opened, some buttons are enabled that should 

not be 
 
Version 6.0.5.7 
November 10, 2010 

• Auto-detection and repair of broken internal attachment links 
• WebBrain Sync 

o Fixed: Status updates from server designated “pending” are sometimes incorrectly detected as errors 
o Improved error reporting 

• Fixes 
o Fixed: Problems with pins in exported SiteBrains 
o Fixed: Setting dictionary does not apply to all open notes windows 
o Fixed: Some notes menus disappear after setting dictionary 
o Fixed: Problems with display of all day events 
o Fixed: Loops in Thought type hierarchies may not be caught and fixed 

 
Version 6.0.5.6 
November 4, 2010 

• Reporting on link types 
o Under the “All” dropdown in reports, there is a “Link Types” submenu 
o Selecting a link type shows all Thoughts connected by the selected type 

• Google Calendar Sync 
o Support for exceptions to repeating events 

§ If an exception has been added to a repeating event in your Google Calendar, the exception 
is reflected in PersonalBrain. 

§ This change prevents a variety of other calendar sync related problems from occurring  
o Improved error handling and logging 

• Replace Attachment Locations command 
o “Replace Attachment Locations” now can be undone and redone. 
o Fixed: Rebuilding the database after using the “Replace Attachments Locations” utility causes old 

locations to return. 
• Repair Orphaned Attachments Utility Added 

o This command is for use if any of the following has happened: 
§ An attachment was added but did not appear 
§ An attachment was added and it is reported to be already attached but the thought with the 

attachment could not be activated 
o The command reviews all attachments in the brain’s database and repairs any missing references 
o If attachments are found whose original thought is unknown, they are added to the home thought 

• Localizations 
o Updated translations for German 

• Fixes 
o Fixed: Adding of attachments sometimes does not work correctly 
o Fixed: Certain unusual problems while syncing with WebBrain 
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o Fixed: “Today” in reports does not report today’s date if PersonalBrain has been open for longer than 
a day 

o Fixed: Undo of set link type cannot be redone 
o Fixed: Toolbar of reports panel does not wrap properly, causing the scrollbar of the reports window to 

appear off-screen in some cases 
o Fixed: Problems with continuous database backup when there are more than 500,000 links 
o Fixed: Backup file for the entries table may increase dramatically in size without an apparent cause 

 
Version 6.0.5.5 
November 1, 2010 

• Fixed: Various problems in version 6.0.5.4 with creating Thoughts and adding attachments 
• Fixed: Various exceptions in log files when interacting with menus 
• Fixed: In some cases, PersonalBrain may hang while attempting to close 

 
Version 6.0.5.4 
October 29, 2010 

• Modification info in reports 
o Reports has an option to show when changes were made for each Thought 
o This option also shows who made the changes if they were not made by the current user 

• TeamBrain Services Support 
o Support for multiple users collaborating on a Brain requires a TeamBrain Services subscription 

(currently only available in private beta) 
o User information for each change is tracked through WebBrain 

§ The Thought Details window shows which user made the last modification 
• Localizations 

o Updated translations for Chinese, German and French 
o Japanese translation of tips 

• Fixes 
o If there is a problem while syncing to WebBrain, additional troubleshooting information is provided so 

errors happening on the server can be easily found 
o Updated libraries for docking framework 
o Changed Windows graphics settings for broader compatibility 
o Fixed: Exceptions after closing brain 
o Fixed: Cannot open Brains created in PersonalBrain 4.X. 
o Fixed: Opening BrainZips under some circumstances causes an OutOfMemory error 
o Fixed: Problems due to missing Thought icons failing to load 

 
Version 6.0.5.1 
October 15, 2010 

• Better looking auto-hide icon  
• Fixes: 

o Java 6 update 22 compatibility 
o If the activation file can’t be written to the normal program location, writes to a user specific location 
o Fixed: Running PersonalBrain using Java 5 does not work properly 

 
Version 6.0.5.0 
October 12, 2010 

• Activation Process 
o Activation can be done directly from PersonalBrain without using the browser 
o Recommendation dialog box does not appear unless requested 

• Fixes 
o Fixed: A problem with the Chinese localization prevents selection of the activation file. 
o Fixed: Negative link widths cause the plex to stop responding 

 
Version 6.0.4.9 
October 9, 2010 

• Activation process clarified 
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• Fixes 
o If Thought names longer than 128 characters were in a Brain converted from version 5.5 and they 

were truncated, the missing portion is automatically recovered.  
o Fixed: Under rare circumstances pins cannot be created and Shift+right-click does not allow deleting 
o Fixed: Exception caused by missing “SendTo” folder on Windows XP 

 
Version 6.0.4.8 
October 5, 2010 

• Updated German language resources 
• Fixes 

o Fixed: Copy and paste of large numbers of Thoughts fails to display confirmation prompt 
o Fixed: Loading fails for Brains if the preference information has been corrupted 

 
Version 6.0.4.7 
October 5, 2010 

• Fixed: Problem loading pins with non-standard GUIDs created by imported data 
 
Version 6.0.4.6 (1st Official Release) 
October 4, 2010 

• Brain Statistics 
o Includes total size of internal attachments 
o Improved formatting for large numbers of Thoughts and other items 

• Fixed: Various problems on startup with certain Brains 
 
Version 6.0.4.3 (Release Candidate) 
September 29, 2010 

• Miscellaneous Enhancements 
o Added commands to change thought privacy to the Edit menu 
o Displays the progress of background event processing when a brain is closing 
o The search results window displays using system colors 
o Double clicking an empty area of the attachments area shows the add attachment dialog 
o Attachment sorting preference is universal 

• Outlook Integration 
o When a contact is added from Outlook, the company name is used for the Thought name if the name 

of a person is not available. 
o Fixed: Drag and drop of multiple items with the same name at once does not work 

• WebBrain Sync Fixes 
o Fixed: Syncing of pins to WebBrain does not work properly and sometimes results in a loss of pins 
o Fixed: Default notes style information (in notes.css) is not used when accessed from WebBrain 

• Fixes 
o Fixed: Types popup menu does not close when spacebar is pressed 
o Fixed: Improper XML files with duplicate tags and types cause a null exception 
o Fixed: Various issues with Type and Tag menus on Linux 
o Fixed: Problems with renaming brain after sync 
o Fixed: When a brain is moved from Windows to Mac OS and there are external attachments, their 

location is not displayed properly 
o Fixed: Right-clicking on an attachment should not start the rename process 
o Fixed: Deleting a tag does not remove it from the past thought list and pins display 
o Fixed: You shouldn't be able to assign a tag to a thought type 
o Fixed: If the set Thought color popup is open and you activate a different thought, it should disappear 
o Fixed: Pressing the spacebar to center active thought in expanded view does not work 
o Fixed: Confirm dialog can sometimes appear underneath the progress dialog when pasting, 

preventing confirmation 
o Fixed: Registration information is saved in the wrong location under Windows XP 

 
Version 6.0.4.2 
September 17, 2010 
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• Optimized background processing of events that update indexes after a large number of changes 
• Miscellaneous Enhancements 

o Updated splash screen, icons for installer, .brain and .brainzip files 
• Fixes 

o Fixed: Importing of large XML files fails 
o Fixed: Some brains cannot be converted to version 6 properly 
o Fixed: Some languages cause the preferences screen to hang 
o Fixed: .brain and .brainzip file extensions are sometimes not registered properly 

 
Version 6.0.4.1 
September 10, 2010 

• WebBrain 
o Encrypted Sync 

§ WebBrain synchronization is protected using 128-bit AES Encryption. (The same encryption 
used by the US government to protect classified information.) 

§ Port 443 is used for encrypted syncs. If your firewall does not enable an SSL connection, you 
can disable encryption by going to Preferences > Advanced and typing “http://webbrain.com” 
as the WebBrain address (If no protocol is specified, https is the default) 

• Mac OS X Specific Changes 
o Printing of notes 

§ The ability to print notes has been added (Notes > File > Print) 
o Fixed (unverified): On some computers, PersonalBrain fails to shutdown 

• Miscellaneous Enhancements 
o Multiple tag deletion 

§ You can now select multiple tags at a time to delete them. Hold down control/command or 
shift to select multiple tags then click the delete button 

o Added a keyboard accelerator for details 
o System colors are used for the search panel and calendar – this makes the UI conform when themes 

such as “High contrast” are applied to the OS 
o When creating thoughts, tags and types can be selected using the keyboard (arrow keys, spacebar, 

and enter) 
o Updated French localization 

• Fixes 
o Fixed: Problem with updating database that could cause errors when syncing (syskey column too 

short) 
o Fixed: Database error when syncing (null not allowed in EntryToObject > objected) 
o Fixed: sometimes deleting of a forgotten thought does not work when there are attachments present 
o Fixed: After closing a brain, the brain buttons are disabled 
o Fixed: when using keyboard to navigate through thought types/tags, list scrolls if necessary 
o Fixed: Thought GUID does not fit in the details window 
o Fixed: Deleting an attachment when there are multiple attachments with same location does not 

always delete the selected attachment 
o Tags panel is updated when preference colors are changed 
o Fixed: Tags count does not update when a tag is deleted 
o Fixed: The select attachment dialog may extend off-screen if there are many file templates present 
o Fixed: The text cursor position is altered when multiple notes editors are present and a change is 

made in one that affects another 
o Fixed: When a type is deleted, it does not disappear from the menu 
o Fixed: Floating notes windows always have spellchecking enabled 

 
Version 6.0.4.0 
September 2, 2010 

• Fixed: Unlinking thoughts and dragging thoughts to change their relationship sometimes does not update the 
display 

 
Version 6.0.3.9 
September 1, 2010 



 

© TheBrain Technologies LP Page 9 of 24  

 

• Improved Performance 
o Significant performance optimizations to the plex frontend and database backend 
o Responsiveness increased by up to 600% in large brains 
o Consistently smooth user interface responsiveness 

• Updated German localization 
• Fixes 

o Fixed: Mouseover highlighting of tag thoughts causes the user interface to pause 
o Fixed: Create BrainZip command recreates the continuous database backup unnecessarily 
o Fixed: Possible lockup of application caused by loading of images 

 
Version 6.0.3.8 
August 25, 2010 

• WebBrain Sync 
o Improved status/error handling 
o Added WebBrain terms notice to the synchronization dialog box 

• Fixes 
o Fixed: The last change made to notes may be lost when a different Thought is activated or 

highlighted and then focus immediately returns to the original Thought 
o Fixed: Sorting of the character L with a stroke through it is incorrect 
o Fixed: The tag usage count does not fit if there are more than 999 occurrences 
o Fixed: Attachments can't be edited in floating Thought windows 
o Minor corrections in text resources 

 
Version 6.0.3.7 
August 23, 2010 

• Multiple Notes Windows 
o Notes for a Thought can be opened in a floating window 

• UI Improvements 
o On Windows, floating tool windows for details, Thought, and notes, are shown with a less prominent 

title bar 
• Fixes 

o Fixed: Sync does not initiate due to missing library 
o Fixed: If multiple attachments are selected, they are not remembered when the highlighted Thought 

changes 
 
Version 6.0.3.6 
August 21, 2010 

• WebBrain Sync 
o If an initial upload of a Brain is interrupted, the next time you sync PersonalBrain will offer to resume 

the previous upload 
o Fixed: Uploads of more than 2 GB do not work 

• Precise Event Times 
o Event times can now be entered using the keyboard to set times precise to the minute 

• Other Changes and Additions 
o Added accelerator for inserting date/time into notes (Ctrl+D).  
o Create Duplicate Child accelerator changed (Ctrl+Shift+D) 
o Updated German translation 

• Fixes: 
o Updated notes editor component (fix for startup in German locale) 
o Adjusted Thought Window layout when name is on a separate row 
o Fixed: When assigning a new Brain GUID, the last completed sync date is not cleared 
o Fixed: OWL import does not inform user of the need to download the necessary libraries 
o Fixed: When a BrainZip is used to move a Brain from one computer to another, sometimes icons are 

not accurate until Thoughts are clicked 
o Fixed: When a BrainZip is being created, no progress dialog is shown 
o Various fixes for exceptions related to failing to load images for preview 
o Fixed: Loading of scaled images causes PB to hang  
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o Fixed: Scaled image files are not deleted when files are deleted 
o Fixed: The selected attachment is lost during mouse-over of another Thought 
o Fixed: Sorting attachments by date does not work 
o Fixed: Overlap of text in attachments window 
o Fixed: Past Thought list scroll button appears in the wrong place at startup 
o Fixed: File length is not getting put into the database 
o Fixed: When importing some MindManager files, notes are not imported 
o Updated library for docking framework 

 
Version 6.0.3.5 
August 8, 2010 

• Keyboard Enhancements 
o The keyboard navigation highlight indicator updates the tools when the “Update tools on highlight of 

Thoughts” preference is enabled 
o Added new accelerators to toggle the following preferences: Update tools on highlight of Thoughts, 

Activate last created Thought, Copy/Cut/Paste notes as text 
o Fixed: Esc should not exit presentation mode if keyboard navigation is active 

• Create Thought Dialog Changes 
o Fixed various problems with consistency, drawing, hiding, and showing of the types and tags pop-ups 
o Enter key can be used for OK even when keyboard focus is on type/tag button 
o Fixed: Sometimes the source thought is not indicated correctly by the link line 
o Fixed: Keyboard focus is not set to the name edit field sometimes 
o Fixed: Esc key does not work properly (green line remains and does not hide pop-ups for type/tag) 
o Fixed: Sometimes the Create Thought Dialog goes behind the main window 

• Attachment Select Dialog 
o Enables sorting options 
o Sizes according to the number of attachments better 
o Allows single click to select an item 
o Allows keyboard selection of an item 

• Attachment List Fixes 
o Fixed: Large images slow down performance 
o Fixed: Icons for images don't retain their correct aspect ratio 
o Fixed: Icons are not shown properly in Mac OS and Linux 

• Other Changes and Additions 
o Thought Types window displays types hierarchically 
o When a message is added via drag and drop from Outlook with the Ctrl key held down and the 

message is made internal, notes are still added, just like when linking 
o Dragging to create links can be canceled by pressing Esc before releasing the mouse button 
o The Thought selection box can be resized 
o Clicking on a search result for an event activates the event in the calendar 
o Edit event dialog fits on a smaller screen 
o Thought tab uses two rows when there is a long thought name 
o Copy/cut/paste accelerators work in the attachments list 
o Brain XML DTD updated (removed unused elements) 

• Added Chinese translation 
• WebBrain Sync Fixes 

o Fixed: When syncing a large number of changes, the sync may seem to complete, but changes are 
not integrated 

• Other Fixes 
o Fixed: In some cases, clicking the “Save” button on the edit event dialog does not work. 
o Fixed: Outlook icon does not load 
o Fixed: Sometimes typed Thought colors do not show until activation 
o Fixed: Clicks that occur just after dismissing a context menu may be misinterpreted as clicks at the 

old mouse co-ordinates 
o Fixed: When resizing instant activate list, the display does not update properly 
o Fixed: When a link is highlighted, the two thoughts that are highlighted are not drawn at the top of the 

Z order 
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o Fixed: Google Calendar sync does inform that authentication has failed if the domain information is 
missing 

o Fixed: Brain XML Export may not work under some circumstances 
o Fixed: Search results for Events without thoughts linked do not show properly 
o Fixed: Importing files does not show the correct number of folders being imported and does not allow 

a second import 
o Fixed: Thought icons are sometimes lost when syncing (also fixes other potential but unreported 

errors with thought type icons) 
o Removed the non-applicable "default" button when setting UI colors 
o Fixed: Sometimes the color button does not know it is the default color 
o Fixed: Thought Icons do not propagate properly 
o Fixed: Thought Types Window does not update as changes are made in the types hierarchy 
o Fixed: Illegal characters can cause problems when renaming a file 
o Fixed: When a file type is changed via rename, the icon of the Thought is not updated 
o Fixed: Attachments context menu is missing open and remove commands for URLs 
o Fixed: The attachment select dialog does not work properly for the remove and open with commands 

 
Version 6.0.3.3 
August 5, 2010 

• WebBrain Sync Fixes 
o Fixed: When a link is assigned a type, the changes may not be synced to WebBrain 

§ Any link types that were assigned but not sync should be re-synced using the “Force re-sync” 
option 

• General Fixes 
o Fixed: Color selection dialog box can appear off-screen 
o Fixed: Temporary files may not be deleted 

 
Version 6.0.3.2 
August 4, 2010 

• WebBrain Sync 
o Added an option to force re-sync of changes since a specified date 

§ This option forces a re-synchronization of all changes on both sides (the local client and the 
remote server) made since the selected date 

§ Normally, this option should not be needed. However, problems that can arise under certain 
circumstances, such as modifications that were made while one of the clocks was incorrectly 
set, can be overcome using this option. 

o Checks local time against server time before initiating any other sync action 
o Fixed: Automatic sync should not start if a dialog box is open 

• Fixes 
o Minor adjustments to New Brain dialog box 

 
Version 6.0.3.1 
August 2, 2010 

• Fixes 
o Fixed: Sync time is not measured correctly 
o Fixed: Problems reporting the last successful sync time  
o Fixed: Missing border around the list of attachments 

 
Version 6.0.3.0 
August 2, 2010 

• WebBrain Sync Enhancements 
o The time of the last successful sync is displayed at the top of the WebBrain sync dialog 
o More efficient status storage and status querying 
o Better error reporting 
o The time of the local machine is verified against that of the server 

§ Sync will not function properly if the local clock is not accurately set 
§ If there is too large a discrepancy between the local and server times, sync will not proceed. 

To fix this error, set the local time of your machine correctly 
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o Fixed: If a Brain is not synced for a long time and another copy of that brain is set to continual 
automatic sync, sync may malfunction  

o Fixed: The accelerator and hint text for the sync toolbar button is wrong 
o Temporary files used for sync and other operations are cleaned up more efficiently 

• Updated installer platform 
 
Version 6.0.2.9 
July 30, 2010 

• Automatic WebBrain Sync 
o If the option “Sync this Brain automatically” is selected, a sync is automatically performed every 5 

minutes. 
o Note: When a sync is done any changes made locally will no longer be undoable. In order to prevent 

accidental loss of undo functionality, automatic syncs are not performed within 30 seconds of any 
undoable activity. Or, to put it another way, automatic sync will not start until no changes have been 
made within the last 30 seconds. 

o If you are not online, sync cannot be performed, however when your connection to the Internet is 
restored, syncing will automatically resume 

• Sync Toolbar Button 
o Press this to initiate a sync 
o Animates while a sync is in progress 
o This button replaces the search web button 

• Redesigned Attachments List Display 
o Displays longer names and locations without truncation – eliminates the need to resize columns 
o Larger attachment icons including image previews 
o Header row removed – change sorting using the sort button in the toolbar 

• Fixes 
o Improved error handling for WebBrain synchronization 
o Fixed: Sometimes fails to detect that the brain is open in another process 
o Fixed: When a new Brain GUID is assigned, Thought URLs in attachments are not updated 
o Fixed: When activating siblings, the scroll position of the siblings changes randomly 
o Fixed: Wallpaper preference does not ask for file if one is missing 
o Fixed: Selecting the existing icon for a thought as a new icon deletes the icon 
o Fixed: Spacebar can't be used to select menus 
o Fixed: In some cases, selecting tags causes an exception message (bug 1121) 
o Fixed: Link properties dialog does not show some controls if link name is very long 
o Fixed: Thought types list does not update after a type has been deleted 

 
Version 6.0.2.8 
July 19, 2010 

• Windows Changes 
o If PersonalBrain is already open, double clicking on a  .brain or .brainzip file opens the selected file 

using the existing instance 
o Fixed: When autohide is being used and the window is not set to “always on top”, the create thought 

dialog appears hidden below the main window. 
• Fixes 

o Various notes editor fixes including: Images in notes are not updated if the local image file is changed 
 
Version 6.0.2.7 
July 16, 2010 

• When a Thought URL is opened and PersonalBrain is already open, its taskbar icon will flash 
• Fixed: When the window is set to “always on top” under Windows, the create thought dialog appears hidden 

below the main window. 
 
Version 6.0.2.6 
July 16, 2010 

• WebBrain Sync 
o Decreased amount of data required for sync 
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o Fixed: Thought icons based on type do not show on WebBrain 
o Fixed: Changes may not be synced if the item modified was updated as part of the last sync 
o Fixed: Thought icons disappear after syncing 

• Fixes 
o Fixed: Repeating events can’t be snoozed 
o Fixed: Paste Thought Icon command is missing from Thought menu 
o Fixed: Searches on tags and types for names, notes, attachments, etcetera do not work 
o Fixed: Issues with verification of the index 
o Fixed: Thought types window should be closed when switching brains 
o Fixed: “Overwrite all” options does not work when pasting Thought types 
o Fixed: Undo does not restore files or folders moved into PB when virtual thoughts are enabled 
o Under windows, always on top status is done with native calls 

 
Version 6.0.2.5 
July 14, 2010 

• Due to a change in the backup format, the continuous backup service will be reinitialized when opening 
Brains for the first time with this release 

• Thought URLs 
o Added a new Thought menu command to copy a Thought URL to the clipboard 
o Thought URLs can be added as attachments to Thoughts and can also be used in notes 
o Links to Thoughts in the same Brain and Thoughts in other Brains are supported 
o Windows only: Thought URLs can be added as hyperlinks so that when they are followed 

PersonalBrain will go to the referenced Thought 
§ In order for this feature to work, you must allow PersonalBrain to communicate over the 

network if your firewall blocks it. For the Windows Firewall, simply click “Allow” when 
prompted after first running PersonalBrain. 

• Additional Changes 
o Thought context menu includes copy as text command 
o Calendar refreshing optimized 
o Updated French localization 

• Calendar Fixes 
o Fixed: Double click to create event and click to deselect event does not work in day view 
o Fixed: Selected events show in the wrong color when highlighted by the mouse pointer 
o Fixed: Shows reminders for forgotten thoughts 
o Fixed: Event search results in calendar do not show if the event does not have a thought associated 

with it 
o Fixed: am/pm indicators should not be used for locales where this is not applicable 
o Fixed: Repeating all day monthly events show on more than one day 

• Fixes 
o Fixed: Syncing with WebBrain sometimes causes thought icons to disappear 
o Fixed: The Notes Insert link to a Thought command fails in some cases due to additional formatting or 

other tags. 
o Fixed: Word import does not import body text as notes 
o Fixed: Overwrite/Skip All option on paste of thoughts is applied to types and tags also 
o Fixed: Sometimes crashes on exit 
o Fixed: “Send to” from Windows Explorer does not work on some computers 
o Fixed: Thought names with more than 128 characters are cut down to 128 characters after a rebuild 

of a Brain database 
o Fixed: Export of BrainEKP XML does not work with tags 
o Fixed: Rename using F2 does not update the Thought tool’s name field 

 
Version 6.0.2.4 
July 7, 2010 

• Notes Editor 
o Links to Thoughts in Notes 

§ When a link to Thought that does not exist is clicked, the option to remove it is given 
§ Fixed: Assigning a new Brain GUID breaks links in notes 
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§ Fixed: The insert command is case-sensitive 
§ Fixed: Links do not work in exported SiteBrains 

o Remembers the position of the text caret when the editor is updated 
• Fixes 

o Fixed: Dragging of thoughts in the plex to rearrange them sometimes does not work  
o Fixed: Can't add/delete attachments to tags 
o Fixed: Attachments on tags do not show the full context menu with copy/move into, etcetera 
o Fixed: Restore button on splitter in transparent mode does not work sometimes 
o Fixed: Tab positions appear on top in advanced tools layout 
o Fixed: Tags popup can appear off-screen 
o Fixed: Sometimes icons don’t appear on typed thoughts after opening a BrainZip until the Brain is 

closed and re-opened 
o Fixed: Dragging to reorder pins does not work 
o Fixed: When activating a child thought then returning to the parent, the scroll position of the child 

thoughts changes 
o Fixed: Tags menu is not drawn in the correct colors when the option to apply colors to Thought 

backgrounds is enabled 
o Fixed: The “Untyped” entry in the Types menu is not drawn with the correct background color when 

the option to apply colors to Thought backgrounds is enabled 
 
Version 6.0.2.3 
July 2, 2010 

• Links to Thoughts in Notes 
o To insert a link to a Thought 

§ Enter the name of the Thought to be linked, select it, and press the “Insert Link to a Thought” 
button 

o To follow a link to a Thought 
§ Hold down the control key and click on the link 

o Once the link has been created, the text of the link can be changed and the Thought can be renamed 
without breaking the link. 

• Added accelerators for the following preferences 
o Hide tag hints 
o Draw links 
o Show siblings 
o Copy/cut/paste notes as text always 

• Additional Changes 
o “Snooze All” button added to reminders dialog 
o Added File > Import > Text Outline command 

§ This command supports importing a text outline using the same formatting as is used when 
pasting a text outline 

o Edit > Copy as Text Outline with Notes also includes URLs in the copied text 
• Fixes 

o Fixed: Highlighting Thoughts does not update tools when plex is in transparent mode 
o Fixed: Brains will not upload to WebBrain if they are the only Brain in use or if they have just been 

created 
o Fixed: Pressing F2 to rename a pin or past thought places the dialog in the wrong location 
o Fixed: The switch name and label command is not disabled properly when there is no label 
o Fixed: Notes menu does not appear in transparent mode 
o Fixed: The types menu is not wide enough to accommodate types with multiple levels of hierarchy 
o Fixed: Tags are not applied to the correct thought when thought was activated through reports 
o Fixed: The tag properties dialog opened from the tags tab is not correct 
o Fixed: Thought colors do no update correctly in the pins and past thoughts list when privacy status is 

changed 
o Fixed: The transparent mode button can overlap the pins  
o Various calendar optimizations and fixes 
o Fixed: Problems when an event is changed from a repeating to a non-repeating event  
o Fixed: Google calendar sync has problems with all day events 
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Version 6.0.2.2 
June 28, 2010 

• Significantly Faster 
o Plex navigation is now 2 times faster than version 5.5 

• Notes 
o Checkboxes in notes 

§ Use the new “Insert Checkbox” command to add a clickable checkbox into notes 
§ This feature makes it easy to create and track task lists 

o Automatically recognizes links that are typed and adds a hyperlink 
o Added new toolbar button “Insert Horizontal Rule” 

• Additional Changes 
o Updated Japanese translation 

 
Version 6.0.2.1 
June 25, 2010 

• Paste Outline Improvements 
o Can include URL attachments 

§ When pasting an outline, if URLs are included, they are added as attachments to the Thought 
they are listed under 

o Can include Thought labels 
§ Text on the same line as a Thought after the vertical bar character (“|”) is added as a label 

o Can include notes 
§ Text prefixed with a dash character (“-”) is added as a note 

o Example: 
Steve Jobs | Founder of Apple 

http://en.wikipedia.org/wiki/Steve_Jobs 
-" I want to put a ding in the universe." 

§ The above text adds a thought named “Steve Jobs” with the label “Founder of Apple”, a link 
to Wikipedia, and a note containing a quote. 

• Fixes 
o Fixed: Pasting an outline hangs PersonalBrain 
o Fixed: Adding a new event does not update the event list until another thought has been activated 
o If an older version of Java is installed in the PersonalBrain program folder, it is removed 

 
Version 6.0.2.0 
June 24, 2010 

• Fixed: Problem with closing/switching Brains 
 
Version 6.0.1.9 
June 24, 2010 

• Fixed: Problem with repeating calendar events 
 
Version 6.0.1.8 
June 24, 2010 

• Thought Tool 
o Type controls added, layout improved 
o Added spell checking support to label field 
o A message is shown when a type or tag is active 

• Calendar 
o The calendar display now uses the full space available and is generally cleaner looking 
o Events for the active thought are displayed in bold on the calendar 
o The list of events for the active thought can be shown by pressing the event count button in the 

calendar toolbar 
o Events are displayed on a single line 

§ Time format is more compact 
§ If a thought is linked to an event, it is shown to the right of the event’s name 

o Ctrl+click to select multiple events (works in the calendar and in the event list) 
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o When multiple events are selected, they can be deleted and linked to/unlinked from the active thought 
as a group 

o Various other calendar fixes 
• Analyze Main Thoughts 

o Shows progress indicator 
o Can be run in the background by closing the progress dialog 
o Top 100 thoughts are added to the selection in order of importance 
o Added accelerator 

• Additional Changes 
o Updated German translation 
o Updated libraries for communicating with Microsoft Outlook 
o Added accelerators for sync and calendar sync 
o Sorting of Thoughts starting with dotted numbered groups is supported (e.g. 1.9 appears before 1.10) 

• Fixes 
o Fixed: Positions of docked tool windows are not loaded at startup 
o Fixed: The order of pins may change when upgrading from 5.5 to 6.0 
o Fixed: Pressing Shift+Context menu key does not work 
o Fixed: Various issues with the Select Content dialog under Linux 
o Fixed: Forward/Back buttons do not work while a tool is maximized 
o Fixed: On resize of transparent window, the tools appear 
o Fixed: Sometimes wallpaper is not included in a BrainZip if the wallpaper was just set 
o Fixed: Apply new tag/type to selection does not work 
o Fixed: Tab characters in thought names are not rendered properly 
o Fixed: ESP Sync should not activate forgotten thoughts 
o Fixed: Rebuild database command does not work 
o Fixed: Paste overwrite prompt hidden behind progress dialog 
o Fixed: Tags tab should be disabled if a type is active 
o Fixed: Private checkbox should be hidden if type is active 
o Fixed: Various problems with window handling 

 
Version 6.0.1.7 
June 19, 2010 

• Thought Types Window 
o Provides a centralized place to see and manage Thought types 
o Create types without the need to assign them to a Thought 
o Review, edit, and delete types easily 
o Available under the Options menu 

• Thought Tool 
o Properties & Attachments tool has been renamed to Thought tool 
o Design has been completely redone for simplicity and compactness 

• Other User Interface Improvements 
o Details tab removed and placed into the Thought menu 
o Improved look and feel of Thoughts in the selection box 
o Create Thought dialog has a larger edit box 
o New icon for adjusting colors of Thoughts and links 
o Improved menu mnemonics 

• Attachments 
o New command: Copy Attachment into Brain 
o Attachments submenu added to the Thought menu 

• Select Related Thoughts 
o Shows quick summary of concepts that are shared between your Brain and the content of the 

attachments by selecting the Thoughts mentioned in the text of the chosen attachments 
o This command is available from the attachment context menu, the Thought > Attachments menu, and 

the Thought icon context menu 
• ESP Sync 

o Faster and more sensitive 
• File > Utilities > Analyze Main Thoughts 
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o Performs a link analysis to determine the relative importance of Thoughts within this Brain 
o The most important Thoughts are presented in a list and are highlighted within the plex using a circle 

whose size shows the relative importance of the Thought 
o To clear the circular highlights, select the Hide Main Analysis command from the Utilities menu 
o Note: this command can take over a minute to execute on a large Brain 

• Fixes 
o Fixed: Notes changes made on WebBrain.com are not displayed when synchronized back to 

PersonalBrain 
o Fixed: Unlinking to remove tags does not work 
o Fixed: The prompt for overwriting tags does not show the tag name properly 
o Fixed: Pasting a URL via the “Paste into Plex” accelerator should not prompt for pasting as an outline 
o Non-applicable paste commands removed from Edit menu 
o Fixed: Transparent mode should not appear in background menu if not supported 
o Fixed: Layout issues in date format dialog box 
o Fixed: Pins of tag thoughts are not converted correctly from version 5.5 
o Fixed: Inaccurate tag usage count shown in the tags tool 
o Fixed: Cancel of paste causes inability to dismiss progress window 

 
Version 6.0.1.6 
June 8, 2010 

• Increased Speed 
o Faster performance of non-plex operations that show Thoughts such instant activation results, 

advanced search results, calendar, and reports 
• Transparent Mode 

o Once you have setup transparent mode in the position you like, it will default to that location the next 
time you enter transparent mode  

• Copy and Paste Fixes 
o Fixed: Paste of thoughts that have the same GUID as a thought that was deleted does not work 

correctly 
o Fixed: Default color and privacy settings are not copied correctly 
o Fixed: The status message has the incorrect number of thoughts modified and created 

• Other Fixes 
o Fixed: Empty files named “notify” are added to the attachments list spontaneously 
o Fixed: Thought backgrounds show even when they are turned off in preferences 
o Possible fix for losing icons when sync is done 
o Fixed: Missing images can cause loading of other images to be delayed 
o Fixed: Problem with detecting if wallpaper is in use 
o Fixed: When a thought type is created the plex is not always refreshed properly 
o Fixed: Loading of tips text in window when no brain is open is not working for Japanese and other 

languages 
o Fixed: When a pin is created using drag and drop, it cannot be removed until you close and re-open 

the brain 
o Fixed: Can create cyclic inheritance by creating a parent thought from a type 
o Fixed: The tip about how to arrange Thoughts is incorrect 

 
Version 6.0.1.5 
June 4, 2010 

• Increased Speed 
o Increased speed of all operations, particularly on Brains with many tags and types 

• Customizable date format for notes 
o To customize the format used when inserting the date and time into notes, use the command in the 

File menu of notes. 
• Improved sorting 

o Thoughts with numbers in their name sort by numerical order if they are otherwise equal up to that 
point. For example, “Thought 9” will appear before “Thought 10” 

• Fixes 
o Fixed: Copy of thought attachments does not work properly 
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o Fixed: Linking to pins does not update the display correctly, causing thoughts to temporarily 
disappear in transparent mode. 

o Improved WebBrain sync error handling 
o Fixed: Can’t open or add attachments to Tag thoughts using some methods 
o Fixed: Minor errors in Dutch text resources 
o Fixed: Cancel of preferences does not cancel text changes 
o Added more information improve interpretation of log messages 
o Fixed: If a pin is created via drag and drop it cannot be removed until the brain is closed 
o Fixed: Instant activate results don't hide after switching brains 
o Fixed: Problem with trimming of thought names in the create thought dialog 
o Fixed: Transparent mode un-maximizes the plex before switching 
o Minor fixes for adding results to the selection 
o Removed null exceptions when a brain is closed 
o Fixed: Tips in French and Japanese do not display correctly 
o Fixed: Japanese resources may not work correctly when launched in Windows Vista or 7 
o Fixed: Possible error causing increased CPU usage when updating attachment index 
o Fixed: Keywords from brains created in PB 3.0 do not get imported as tags 
o Fixed: Spellchecking of thoughts in the creation dialog does not work 

 
Version 6.0.1.4 
May 30, 2010 

• Fixes 
o Fixed: Problems running on Mac OS and Linux after closing a brain since version 6.0.1.3 
o Fixed: Main reports menu and custom report window take a long time to display 
o Fixed: Undo of certain commands does not work 
o Fixed: Copy/paste commands do not work when there is no network connection 
o Changes to “Send to” functionality to improve compatibility with Windows XP 

 
Version 6.0.1.3 
May 28, 2010 

• Windows Explorer Integration 
o The “Send To” submenu of the Windows Explorer file context menu that appears on right-click of a 

file or folder now contains a “PersonalBrain” item for the currently open Brain. 
o Use the Send To PersonalBrain command 

§ On a file to send a copy to your Brain 
§ On a folder to import a copy into your Brain 

o Items added can be sent to the active thought or to the home thought. This setting is configurable in 
Preferences > UI 

o When an item is added, PersonalBrain shows a message in the upper-right corner confirming the 
addition and where it was added 

• Calendar 
o Double click on calendar to create an event 
o Events can be selected by clicking on them in the calendar. Ctrl+Click (Command+Click on Mac) to 

select multiple events. 
§ Once selected, events can be deleted via the delete button 

• Fixes 
o Fixed: When a Brain is converted to 6.0 format sometimes new tags are created 
o Fixed: Potential problems with operations that cycle through all thoughts such as rebuilding of 

indexes & the database 
o Fixed: Calendar sync fails to sync events from PB to the Google Calendar if a prior sync has not been 

done to populate events created in Google Calendar to PB 
o Fixed: Excel outline paste not working as expected in some circumstances 
o Fixed: Selection context menu for delete not showing correctly w/ respect to "Forget Thoughts before 

deleting" preference 
o Fixed: Importing folders does not work properly on Windows 7 
o Fixed: Renaming of a thought causes exceptions to be logged 
o Fixed: Sorting of Thoughts where the first words begin the same but one ends earlier is not correct  
o Fixed: Assigning Thought type at the time of creation does not work when trailing spaces are present 
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Version 6.0.1.2 
May 26, 2010 

• Visible Thought Types 
o Thought Types are now visible as special Thoughts, similar to Tag Thoughts. 
o To activate a type, use instant activate or select Type > Activate from the Properties & Attachments 

tool 
o Type Thoughts are displayed in the plex with all their instances as children 
o Types have a dotted outline to distinguish them from normal thoughts 
o Types can be edited by activating them and using the Properties & Attachments tool, just like any 

other Thought 
o Similarly, Types can be deleted by activating them, then deleting them via the Thought menu or via 

the context menu 
o When a Type is created, it is activated so that you can set its properties easily 
o Like Tag Thoughts, Type Thoughts are only displayed in the plex when they are active and thus do 

not clutter the plex unnecessarily 
o To set a Thought’s type, link to the type as a parent. You can also still set the type using the menus 

and the via the Properties and Attachments tool of a Thought. 
o A Thought’s type can be removed by unlinking it. 
o Instances of a Type can be created/linked by dragging from the child gate of a Type Thought 
o Supertypes can be created/linked by dragging from the parent gate of a Type Thought 
o If you want to reuse the Types you have created in one Brain you can copy and paste them from one 

Brain to another just like other Thoughts 
• Fixes 

o Fixed: Opening a BrainZip when no other Brain is open fails 
o Fixed: Assigning a Super Type to a Thought with many subtypes causes PB to freeze 
o Fixed: Switching Brains while in Outline or Expanded views causes problems with the display 
o Fixed: Sometimes Thoughts are not arranged in the correct order when not in normal view 
o Fixed: Various issues with the notes editor 
o Fixed: Cursor flashes when moved over corner buttons 

 
Version 6.0.1.1 
May 21, 2010 

• Synchronization 
o When sync is complete, a status message is displayed in the upper right corner 
o First time sync is more efficient 

• Fixes 
o Fixed: Undo/redo of link event to thought is not named correctly 
o Fixed: Files and icons are not copied when copy/paste of thoughts between brains 
o Fixed: Thought Type loops of inheritance can cause PB to fail to display type menus 
o Fixed: Thought types are not set properly on copy/paste 
o Fixed: Notes menu stops working and various other problems with notes editor 
o Fixed: Illegal characters can be entered in rename/create brain 
o Fixed: Accelerator to auto-hide when in transparent mode should be disabled 
o Fixed: Problems with remembering window placement 
o Fixed: On drag and drop, prompts for every file instead of using Yes for All/Cancel for All setting 
o Fixed: On Mac OS, files within folders that have special characters in them do not open properly 
o Fixed: Sometimes the hot key does not work due to not pressing the alt key early enough 
o Fixed: Create dialogue goes behind the PB window when in auto-hide the first time you create a 

Thought 
o Fixed: When “Use Tablet-compatible edit boxes” is selected, the search edit box disappears in 

transparent mode 
o Fixed: Event reminders window grows larger than screen height 
o Fixed: On merge of a brain, asks if indexing should be done in the imported brain 

 
Version 6.0.1.0 
May 19, 2010 

• Synchronization 
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o Improved detection of last sync point 
o Supports syncing from a BrainZip upload without redundant data transfer 

• Fixes 
o Fixed: Auto-hide does not hide on some computers 
o Fixed: Turning off spellchecking does not remove last set of the red lines indicating misspellings 

 
Version 6.0.0.8 
May 16, 2010 

• Activation 
o Fixed: Registration information is spontaneously lost under certain circumstances 

§ PersonalBrain will have to be re-activated if it was previously activated on any prior version of 
6.0. Unfortunately this is necessary to prevent registration information from being lost. 

o The activation process has been changed so that activations during the beta period will always be 
approved by the server 

• Removed unneeded step from installer 
• Localization 

o Includes updated German language resources 
• Fixes 

o Fixed: Problems with create Thought dialog always on top status 
o Fixed: Problems with functions that cycle through all Thoughts 
o Fixed: Various bugs in notes editor 

 
Version 6.0.0.7 
May 14, 2010 

• Menus 
o When the context menu key is used to open the Thought context menu, the attachments context 

menu is added as a submenu 
o Capture Image to Clipboard command moved 

• Localization 
o Includes updated Dutch language resources 

• Mac OS X 
o Mac OS 1.4 is supported 
o Note: If you are not running at least Java 6 update 14, transparent mode will not be available 

• Linux 
o Fixed: Does not start on Linux 
o Note: Unfortunately, transparent mode had to be removed from the Linux version in order to make it 

stable 
• Fixes 

o Fixed: On non-English resources, the activation file cannot be selected 
o Fixed: Capture image command does not hide the menu prior to capture 
o Fixed: Various transparency issues 
o Fixed: Tags and types are not assigned on Thought creations when auto-capitalization is used or the 

automatic context-sensitive naming is used 
o Fixed: Closing the Create Thought Dialog using Alt+F4 does not cancel the operation 
o Fixed: Pressing Esc to cancel a sync operation does not cancel properly 

 
Version 6.0.0.6 
May 13, 2010 

• Calendar 
o New event context menu allows events to be linked to any one Thought or none at all, instead of 

being “stuck” on the Thought where they were created. 
o This allows events created via Google Calendar sync to be linked to Thoughts 
o The week number complies with the ISO week number standard 
o Fixed: Context menu for events on reminder dialog should not show "Complete" command 
o Fixed: Event context menu position for day view is wrong 
o Fixed: When event start time is changed, change is not saved 

• Google Calendar Sync 
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o Shows a progress dialog 
o Closing the progress dialog allows the sync to continue in the background 

• Fixed problems with activation 
o If you have already registered and activated PersonalBrain, you may have to repeat the activation 

process after installing this upgrade 
• Fixes 

o Fixed: Statistics take a very long time to be generated 
o Fixed: When a Brain is loaded, PersonalBrain will return to transparent mode if that was the mode it 

was in when started 
o Installer does not prompt for language selection 
o Fixed: Installer registers uninstall as PersonalBrain 5 

 
Version 6.0.0.5 
May 11, 2010 

• Transparent Brain Mode 
o Resize icon shows mouse cursor hint on mouse-over 
o On Windows, entering transparent mode does not remove the window from the task bar 
o Added accelerator to enter transparent mode 
o When closed in transparent mode, PersonalBrain will resume in the same mode and position 

• Menus 
o Moved Presentation and Transparent mode entries to Window menu on Windows 
o New attachment context menus added – right-click on the attachment icon (in the plex to the left of 

the Thought name) to show this menu 
§ Most attachment related items have been moved here from the Thought context menu 

• Capture Image to Clipboard  
o Allows you to capture an image from any part of your screen that is placed onto the clipboard 
o Paste the image as an attachment, into notes, as a Thought icon, or into another program  
o This command is under the Edit menu 

• Fixes 
o Changes made to auto-hide mode settings (hopefully this will address problems with not hiding) 
o Fixed: Database update status may not be registered in the automatic backup, resulting in BrainZips 

that mistakenly try to re-run updates 
o Fixed resource errors referencing WebBrain instead of PersonalBrain 
o Validates window position on entering/exiting transparent and mini modes, preventing the window 

drag handle from being placed off-screen 
o Fixed: When the PersonalBrain window is not active, dragging a thought does not show proper 

feedback (the thought stays still) 
o Fixed: The instant activate search box and results pane can be resized to nothing 
o Fixed: Double clicks on scroll buttons should not maximize/minimize the plex 
o Fixed: Dates on messages from Apple mail are incorrect in search results 
o Fixed: Wallpaper is not loaded when a brain is moved from its original location 
o Fixed: The types list incorrectly redraws when the properties window is narrow 
o Fixed: The open attachment dialog flashes when Shift+Enter is used on a Thought with multiple 

attachments 
o Fixed: Links to indicate the source Thought are not shown when a Thought creation is initiated via 

menu or keyboard command 
o Fixed: English cannot be set as the default language if the system locale matches another existing 

language 
o Installer ensures the minimum version of Java is 6u14 
o If the installer downloads Java, it is setup as a shared JRE 
o When a brain that older than the trial period is opened, the user is informed that pro features will not 

be available 
 
Version 6.0.0.4 
May 5, 2010 

• Transparent Brain Mode 
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o Provides truly seamless access to your Brain while you use any other application popping it out of a 
window and layering your Thoughts directly above other applications 

o View your Brain on top of whatever else you are doing without obscuring a lot of information  
o Click the icon in the upper right of the plex to enter transparent mode 
o Miniature Brain Mode 

§ Transparent mode lets you miniaturize your Brain to just the active thought so that you can 
always have your Thoughts at your fingertips while using just a few square inches of space 

§ While in transparent mode, click the title bar (the Brain icon with the current Brain name in it 
at the top of the window) to toggle miniature mode 

• New Create/Edit Thought Interface 
o When creating a thought, you can now set the tags and type of the thought at the time of creation 
o If you link to an existing Thought, you can set the type of the thought 
o The context command to rename a thought (accessible via F2) can now be used to both rename as 

well as set the type and tags 
• Simple WebBrain Uploading 

o Publish your Brain to WebBrain with a single command 
o You online Brain serves as a backup in case your computer hard drive crashes or you lose your 

laptop 
o Once your Brain is online, update it with changes without the need to re-send everything 

• Synchronization Overview 
o Put a copy of your Brain on another computer and synchronize changes between computers via 

WebBrain 
o Make changes to your Brain on any machine at any time (even concurrently on multiple machines) 

and synchronize the changes across all instances of your Brain 
o Keep your Brain on your laptop and desktop machines, or home and work - anything you add or 

change to one copy will be automatically migrated to other 
• Synchronization Setup 

o Upload to WebBrain 
§ Create an account at webbrain.com 
§ Open your Brain and select File > Synchronize Brain with WebBrain 
§ Note: You can continue working in your brain and allow sync to work in the background by 

closing the status window 
o Copy the Brain to another machine 

§ After the sync has been completed, place a copy of your Brain on another machine (by 
copying the Brain file and folder or by using a BrainZip) 

o Sync at your convenience 
§ To upload any changes that have been made and to receive any changes that have been 

made elsewhere, simply run the sync again 
• Collaboration using Sync 

o Multiple users can all work in the same Brain and the changes each user makes will still be 
synchronized across the different copies via WebBrain 

o Currently, in order to facilitate this, all users must utilize the same WebBrain account as only the 
Brain owner is given permission to modify the Brain 

• Sync Conflict Resolution 
o If you change the same object from different copies between syncs, the most recent change will 

override the others 
o If you delete an object from one brain but had made changes in a different copy since the last sync, 

that object will be reconstituted with the changes 
• Tags 

o Tags can have notes and attachments 
• System Changes 

o A completely revamped database, featuring increased speed and reliability, especially with large 
brains 

o Initial loading of a large brain is faster as are navigation and other actions 
o The new storage format is not backward compatible 
o Much smaller installation package download size 

• Calendar Sync 
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o The built-in calendar can be synced with your Google Calendar via the File > Synchronize Calendar 
with Google Calendar command 

o Changes made to your local Calendar will be reflected in Google Calendar and vice-versa. 
o You can use the Google Calendar as an intermediate to sync with other calendars such as iCal and 

Outlook. Simply sync the Calendar with Google, then sync Google with your other calendar. 
§ Outlook: http://www.google.com/support/calendar/bin/answer.py?hl=en&answer=89955 
§ iCal: http://www.google.com/support/calendar/bin/answer.py?hl=en&answer=99358#ical 

• Other Calendar Improvements 
o Events can be edited, deleted, added, and marked as complete via the context menu, which is now 

accessible from the list of event reminders and the calendar view itself 
o Multi event deleting and dismissing 

• Localization 
o The user interface language is automatically set based on your system locale, however you can now 

change the language via Preferences > General 
o Selection title and rename title text can be localized 

• User Interface 
o Menus reorganized and cleaned up 
o Menus are shorter as non-applicable menu items are automatically hidden 
o The following commands have been moved from the Thought menu to the attachment context menu: 

Open attachment with, Remove attachment, Move File Into/Out of Brain 
o Improved Mac OS X look and feel 
o The instant search text box and results windows can be resized by dragging the right edge. Double-

click on the edge to reset to the default size 
• Other Changes and Improvements 

o Images copied into the clipboard can now be pasted as attachments 
o Focus returns to search after close of properties window 
o The color/icon of thoughts in reports lists are updated when types are changed 
o Improved saving of window positions 

§ Saves float window position even if docked 
§ Other minor improvements 

o Added ability to set focus to search button via Tab key 
o Shift-select of items in reports is faster 
o Non-character based fonts are filtered out of the UI selection tools 

• Fixes 
o Fixed: Reset button on custom report dialog box does not work as expected 
o Fixed: When an event is deleted, an exception appears in the log 
o Fixed: On Mac OS and Linux, spacebar to re-center plex did not work 
o Removed non-applicable accelerator "privacy" 
o Fixed: Color of select attachment to add text is wrong 
o Fixed: Caret position for thought name in properties window is set at start instead of end, preventing 

scroll on long names 
o Fixed: Not all colors update in real time as they are changed in preferences 
o Fixed: Order of tools tabs is lost on maximize of plex 
o Fixed: Ctrl+click on gate with new thought type not working 
o Fixed: Deleting a Thought does not delete Thought folder 
o Fewer threads are used, consuming fewer system resources 
o Fixed: Page Setup and Multi-Page Poster Printing should not be enabled if no Brain has been loaded 
o Fixed: Deleting a Thought that has a Thought folder but no attachments does not delete the folder 
o Fixed: you open the P & A window via keyboard (Alt+T,S), then right click on a attachment and select 

rename, PB briefly lets you edit the name of the file then takes the focus away 
o Fixed: Tab key cannot be used to set focus to the search button 
o Fixed: Attribute date values are not properly formatted as dates in exported XML 
o Fixed: Undo of delete event does not restore all attributes properly 
o Fixed: Files that can’t be moved due to being open are not handled correctly on a move file into/out of 

brain command 
o Fixed: Linking to a tag thought via the “link to existing” function causes the tag thought to show in the 

plex 
o Fixed: Long link type names cause the link properties window to layout improperly 
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o Fixed: The calendar year edit box does not disappear in some cases  
o Fixed: The order of thoughts switches randomly when thoughts have the same name 
o Fixed: Esc should not exit presentation mode when instant search box has text in it 
o Fixed: Color selection wheel is sometimes black 
o Fixed: Keyboard accelerators do not work when the focus is on a  floating properties window 
o Fixed: Saved expanded views that contain deleted or forgotten thoughts do not load properly 
o Fixed: Various bugs in notes editor 
o Fixed: Indexing of very document with a very large number of unique terms does not include all 

terms. 
o Fixed: The message “Search index may be missing some elements” is  incorrectly displayed under 

certain circumstances. 
o Fixed: Incorrect display of the number of attachments (Internal, External and URL) in the Brain 

Statistics dialog 
o Fixed: Incorrect display of the Attachment Extensions in the Attachments submenu of the Reports tab 

and in the Custom Report dialog 
o Fixed: “Thoughts with notes” report is not working 
o Fixed: Tags hints in the plex can be partially obscured by other Thoughts 
o Fixed: Enter and Esc keys don’t work on the Preferences dialog 
o Fixed: If a non-repeating event is unchecked for completion then the percent complete is reset to 

zero. 
o Fixed: Preference dialog cannot be dismissed using the OK button due to registry type error 
o Fixed: Very large files cannot be attached 
o Fixed: When dragging the window, PB freezes momentarily 
o Fixed: Editing an all day event and deselecting it does not show proper window controls 
o Fixed: The first monthly recurring event (day of month) does not show on calendar 
o Fixed: Sometimes dragging a thought does not provide proper visual feedback 

• Linux Specific Fixes 
o Fixed: Paste sometimes freezes 
o Fixed: Edit > Paste into Plex accelerator hangs when you paste a web link 

• Mac OS X Specific Fixes 
o Fixed: Problem with renaming during BrainZip operation  
o Fixed: Search results for Calendar/Address Book/Mail objects do not show if none of these objects 

exist in the brain 
o Fixed: Names of tags are cut off in tags panel 
o Fixed: Presentation mode does not cover the edges of the screen 
o Fixed: Errors appear sometimes when displaying address book search results 
o Fixed: Sometimes drag and drop defaults to the wrong operation (move vs. link) when dragging from 

Quick Look 
o Fixed: Can't drag and drop from Chrome 
o Fixed: Filtering of search results using "Only under active" does not work for some items 

• PersonalBrain XML Changes 
o All dates are now encoded to include time zone information 
o Attribute date information is no longer encoded in milliseconds 
o New tags personalBrainVersion and telepathyVersion 

§ personalBrainVersion must be at least 5519 
§ telepathyVersion must be missing or 10 


